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Chess-Ant Introduction

Simulator to solve chess problems with MCTS Solver and Genetic
Programming.

chess_ant.py is based on the code of
deap/examples/gp/ant.py [https://github.com/DEAP/deap/blob/master/examples/gp/ant.py].


Requirements

On Ubuntu:

sudo -H -s
apt install python3-pip
pip3 install -r requirements.txt
exit





Or:

pip3 install chess
pip3 install deap
pip3 install mcts
pip3 install mcts-solver





Or:

pip3 install chess-ant






	python-chess: a chess library for
Python [https://github.com/niklasf/python-chess]


	DEAP [https://github.com/DEAP/deap]


	MCTS [https://github.com/pbsinclair42/MCTS]


	chess-ant [https://github.com/akuroiwa/chess-ant]


	chess-classification [https://github.com/akuroiwa/chess-classification]


	mcts-solver [https://github.com/akuroiwa/mcts-solver]






General Usage

Sample chess problems are available in pgn/.
Jerry [https://github.com/asdfjkl/jerry] is useful for pasting
Forsyth-Edwards Notation (FEN).

cd chess-ant/chess-ant/
git checkout -b test-run
python3 chess_ant.py --help
python3 chess_ant.py --auto --fen "7k/1Q6/8/8/5N2/1B6/8/3K4 w - - 0 1"
python3 chess_ant.py -a -c -p "my-pgn" -l1 -n100 -g10 -f "7k/1Q6/8/8/5N2/1B6/8/3K4 w - - 0 1"





If you installed chess-ant from PyPI:

chess-ant --help
chess-ant -a -n100 -g5 -f "7r/8/8/8/7k/2q5/6P1/6NK b - - 0 1"





This command will output the wrong answer.
It will take some time, but the following command will output correctly.

chess-ant -a -n1000 -g5 -f "7r/8/8/8/7k/2q5/6P1/6NK b - - 0 1"







Chess-Classification

Version 0.0.1 of genPgn.py contains the Walrus operator, so it only works with Python 3.8 or higher.
Please install Pytorch before installing Simple Transformers.

sudo -H -s
pip3 install pandas
pip3 install simpletransformers
apt install stockfish
pip3 install chess-classification
exit
genPgn --help
genPgn -l 10 -t 1 -p "train-pgn" -f "3qkbnr/8/8/8/8/8/PPPPPPPP/RNBQKBNR w - - 0 1"
cat train-pgn/train-*.pgn >> train-pgn/1.pgn
rm train-pgn/train-*.pgn
genPgn -l 10 -t 1 -p "train-pgn" -f "rnbqkbnr/pppppppp/8/8/8/8/8/3QKBNR w - - 0 1"
cat train-pgn/train-*.pgn >> train-pgn/2.pgn
rm train-pgn/train-*.pgn
genPgn -l 10 -t 1 -p "train-pgn" -f "4k3/pppppppp/8/8/8/8/PPPPPPPP/4K3 w - - 0 1"
cat train-pgn/train-*.pgn >> train-pgn/3.pgn
rm train-pgn/train-*.pgn
importPgn -p "train-pgn"
genPgn -l 10 -t 1 -p "eval-pgn" -f "3qkbnr/8/8/8/8/8/PPPPPPPP/RNBQKBNR w - - 0 1"
cat eval-pgn/train-*.pgn >> eval-pgn/1.pgn
rm eval-pgn/train-*.pgn
genPgn -l 10 -t 1 -p "eval-pgn" -f "rnbqkbnr/pppppppp/8/8/8/8/8/3QKBNR w - - 0 1"
cat eval-pgn/train-*.pgn >> eval-pgn/2.pgn
rm eval-pgn/train-*.pgn
genPgn -l 10 -t 1 -p "eval-pgn" -f "4k3/pppppppp/8/8/8/8/PPPPPPPP/4K3 w - - 0 1"
cat eval-pgn/train-*.pgn >> eval-pgn/3.pgn
rm eval-pgn/train-*.pgn
importPgn -p "eval-pgn"





from chess_classification.chess_classification import ChessClassification
classification = ChessClassification()





Loading a local save:

classification = ChessClassification("local-path/your-outputs")





Train or retrain:

classification.train_and_eval("train-pgn/fen.json", "eval-pgn/fen.json")





Test:

my_fen = "7r/8/8/8/7k/2q5/6P1/6NK b - - 0 1"
classification.predict_fen(my_fen)







	predictions

	labels



	1-0

	2



	0-1

	1



	1/2-1/2

	0






With chess_ant.py:

chess-ant -d -n100 -g5 -f "6rk/4pppp/8/8/3Q4/8/RB2PPPP/R6K w - - 0 1"





Loading a local save:

chess-ant -d -n100 -g5 -f "6rk/4pppp/8/8/3Q4/8/RB2PPPP/R6K w - - 0 1" --model-outputs "local-path/your-outputs"






	Simple Transformers [https://github.com/ThilinaRajapakse/simpletransformers]


	Start Locally | PyTorch [https://pytorch.org/get-started/locally/]


	pandas [https://pandas.pydata.org/]


	Chess-Classification [https://github.com/akuroiwa/chess-classification]





Todo


	It’s too slow.


	Low correct answer rate.


	Parallelization.


	Support for other board games like shogi.


	Support for Universal Chess Interface (UCI).


	Docstring.


	Boil spaghetti code.










            

          

      

      

    

  

    
      
          
            
  
Chess-Ant Article


	author:

	Akihiro Kuroiwa



	date:

	2021/12/25



	abstract:

	Like AlphaFold developed by DeepMind, MCTS can be applied to bioinformatics and cheminformatics.
Chess-Ant is influenced by AlphaZero, but tries a different method.
I would like to show the possibility that the combination of MCTS Solver and Genetic Programming can be put to practical use.






Influence from AlphaZero

A variant of the Polynomial Upper Confidence Tree (PUCT) introduced in AlphaGo Zero and AlphaZero complements the exploration rate \(C(s)\) with the prior probability \(P(s,a)\).  My chess-ant uses the conventional Upper Confidence Tree (UCT)
and replaces the adjustment of the constant \(C\) with Genetic Programming
(GP) [1]. From \(1/\sqrt{1}\) to \(1/\sqrt{9}\), GP chooses the value of the constant \(C\) according to the conditions.
Depending on the value of the constant \(C\),
chess_ant.py will either actively or passively search.

AlphaZero’s PUCT [2] [3] [4] [5]:


\[ \begin{align}\begin{aligned}a_{t} = arg\, max_{a}(Q(s_{t}, a) + U(s_{t}, a))\\U(s,a)=C(s)P(s,a)\frac{\sqrt{N(s)}}{{1+N(s,a)}}\\C(s)=log\frac{1+N(s)+c_{base}}{c_{base}}+c_{init}\end{aligned}\end{align} \]

A deep neural network \((p, v) = f_{\theta}(s)\) with parameters \(\theta\) evaluates the leaf node \(s_{L}\) :


\[(p, v) = f_{\theta}(s_{L})\]

Initialize:


\[ \begin{align}\begin{aligned}N(s_{L} , a) = 0\\W(s_{L} , a) = 0\\Q(s_{L} , a) = 0\\P(s_{L} , a) = p_{a}\end{aligned}\end{align} \]

Update:


\[ \begin{align}\begin{aligned}t \leq L\\N(s_{t} , a_{t}) = N(s_{t} , a_{t}) + 1\\W (s_{t} , a_{t}) = W(s_{t} , a_{t}) + v\\Q(s_{t} , a_{t}) = \frac{W(s_{t} , a_{t})}{N(s_{t} , a_{t})}\end{aligned}\end{align} \]



	
	Details





	(s,a)

	Each state-action pair.



	N(s)

	The parent visit count.



	N(s,a)

	The visit count.



	W(s,a)

	The total action-value.



	Q(s,a)

	The mean action-value.



	P(s,a)

	The prior probability of selecting a in s.



	C(s)

	The exploration rate.



	p

	A vector of Move probabilities (predicted by a deep neural network).



	v

	A scalar value (predicted by a deep neural network).






Chess-Ant’s UCT [6] [7] [8] [9] [10]:


\[ \begin{align}\begin{aligned}a_{t} = arg\, max_{a}(Q(s_{t}, a) + C_{gp}\sqrt\frac{2lnN(s_{t})}{N(s_{t},a)})\\\begin{split}C_{gp} = \begin{cases}
1/\sqrt{1}, \\
1/\sqrt{2}, \\
1/\sqrt{3}, \\
1/\sqrt{4}, \\
1/\sqrt{5}, & \mbox{If the previously selected node state is under certain conditions} \\
1/\sqrt{6}, \\
1/\sqrt{7}, \\
1/\sqrt{8}, \\
1/\sqrt{9},
\end{cases}\end{split}\end{aligned}\end{align} \]

The judgment conditions are as follows:



	Conditions

	Details





	if_improvement

	If UCT increases from the previous time



	if_shortcut

	If move_stack is shorter than last time



	if_result

	Whether the last time rollout was a win, a loss or a draw



	if_pruning

	Whether UCT was infinity, -infinity or something else



	if_is_check

	Is the board of the node selected last time checked?






Also, since GP can be redone in each generation, it is possible to
prevent the UCT from being highly evaluated at the beginning of the
search based on the number of visits. It may get the effect of this
paper [11].



MCTS Solver

With the introduction of MCTS Solver [12]  [13], chess-ant will cut branches to speed up
and reduce wrong answers.

The reason for the significant changes to the pseudocode in the paper is
that the code for the package [https://github.com/pbsinclair42/MCTS] referenced by the inherited classes is
written differently.

In addition, there is no goto in Python, so there is extra code. In the
pseudo code, everything is completed inside the MCTS Solver, but in
chess_ant.py, it is written separately in _executeRound(). Execute
rollout in mctsSolver(), perform processing such as pruning, output
reward like rollout, and input it to backpropogate().

Like negamax, the MCTS solver is a recursive function and requires a stop condition.



Parallelization

In mcts-solver 0.0.5, with the help of OpenAI’s ChatGPT and Google Bard, I modified the code to allow parallel processing [14] [15].
Tree parallelization is more difficult than root parallelization because it requires the use of locks.
I’m not sure if these changes are working correctly, so they may change significantly in the future.
Context managers [https://stackoverflow.com/questions/18386616/can-i-acquire-multiprocessings-lock-in-a-with-statement] are useful, but they can get you into trouble if you use them incorrectly.



Change History

Since both chess-classification and chem-classification use the same algorithm, I made similar changes at the same time.

In chess-classification 0.0.4, fen is separated into tokens to create a dataset. The fen is separated by columns instead of letter by letter.

Corrected by adding math.sqrt(2) since there was an error in the UCB1 algorithm until chess-ant 0.0.5 manual.
It seems that the author of mcts initially set explorationConstant = 1 / math.sqrt(2) in mcts.py to cancel out math.sqrt(2).
I added a new terminal called selectNodeEphemeralConstant to replace the ephemeral constant in chess-ant 0.0.6.

According to Issues #658 [https://github.com/DEAP/deap/issues/658], Deap does not work with Python 3.10, but with version 3.11.

In ~/.bashrc or ~/.bash_aliases:

# Python version
alias python3='/usr/bin/python3.11'





and execute source command:

source ~/.bash_aliases





Another method is update-alternatives.

update-alternatives --install /usr/bin/python3 python3 /usr/bin/python3.10 2
update-alternatives --install /usr/bin/python3 python3 /usr/bin/python3.11 1
update-alternatives --config python3
python3 --version





To revert to the original version that was set as top priority:

update-alternatives --auto python3





Please note that as of December 2022, gnome-terminal does not start with Python 3.11 on Ubuntu 22.04.1 LTS.

A more common method is to use venv:

sudo apt install python3.11-venv
python3.11 -m venv ~/.venv3.11
source ~/.venv3.11/bin/activate
which pip3





To finish:

deactivate





In chess-classification 0.0.5, you can load a local save.

In order to shorten the training time, [16] the conventional model was changed to the checkpoint google/electra-small-discriminator [17] of the electra model.

My pgn files are more like tactics [18]  [19] than chess problems, so it’s more efficient to create a dataset from tactics. More than 300 rows of pgn data are required for model training and model evaluation in order to increase the accuracy rate.



Development Plan


Todo

As another project, I will introduce deep learning [20]  [21] for Natural Language Processing (NLP) in FEN’s win
/ loss evaluation.

genPgn.py automatically plays with stockfish and outputs PGN files. By
the way, version 0.0.1 of genPgn.py contains the walrus operator, so it only works with
Python 3.8 or higher. importPgn.py creates a dataset from PGN files.
chess_classification.py generates a trained model with simple
transformers. I plan to use this trained model to replace the rollout of
chess_ant.py, like AlphaZero.
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py-chessboardjs

Chess GUI using pywebview and chessboard.js.
The main files are start.py, js/my-script.js and index.html.

Chess-Ant is currently too slow to function as a chess engine. To make
matters worse, there is a glitch in the call to chess-ant. It is
possible to experiment by loading pgn and having it solve the problem.


Installation

Please read the pywebview [https://pywebview.flowrl.com/] and
PyGObject [https://pygobject.readthedocs.io/en/latest/] manuals, and
install dependent packages before proceeding.

If you are Ubuntu user:

sudo apt install python3-venv
python3.11 -m venv ~/.venv3.11
source ~/.venv3.11/bin/activate
which pip
pip install py-chessboardjs[gtk]





If you want to install it on local repository:

cd py-chessboardjs
pip install .[gtk]





QT user:

pip install py-chessboardjs[qt]





CEF user:

pip install py-chessboardjs[cef]





Install your favorite UCI engine:

sudo apt install stockfish







Usage

py-chessboardjs-gtk





py-chessboardjs-qt





py-chessboardjs-cef







Related Links


	pywebview [https://pywebview.flowrl.com/]


	chessboard.js [https://chessboardjs.com/]


	chess.js [https://github.com/jhlywa/chess.js]


	Bootstrap [https://getbootstrap.com/]








            

          

      

      

    

  

    
      
          
            
  
Chem-Ant Introduction

Select material candidates to output molecules similar to the target molecule with MCTS Solver and Genetic Programming.

similarity_ant.py is based on the code of
deap/examples/gp/ant.py [https://github.com/DEAP/deap/blob/master/examples/gp/ant.py].


Requirements

On Ubuntu:

sudo -H -s
apt install python3-pip
pip3 install -r requirements.txt
exit





Or:

pip3 install deap
pip3 install mcts
pip3 install rdkit
pip3 install global_chem_extensions
pip3 install mcts-solver





Or:

pip3 install chem-ant





If you want to use chem-ant with chem-classification:

pip3 install simpletransformers





Or:

pip3 install chem-classification






	DEAP [https://github.com/DEAP/deap]


	MCTS [https://github.com/pbsinclair42/MCTS]


	RDKit [https://www.rdkit.org/]


	rdkit-pypi [https://pypi.org/project/rdkit-pypi/]


	Global-Chem [https://github.com/Sulstice/global-chem]


	chem-ant [https://github.com/akuroiwa/chem-ant]


	chem-classification [https://github.com/akuroiwa/chem-classification]


	mcts-solver [https://github.com/akuroiwa/mcts-solver]






General Usage

By default, you get a list of molecules from smiles.csv. The target is Nirmatrelvir. From that list, the best material for the fragments is selected.  The output csv file also contains molecules created during the execution of mcts.  If you want to reuse the csv file as a smiles list, add --select option.  If you want to run commands directly without installing the packages, execute just like python3 similarity_mcts.py --help:

similarity-mcts --help
similarity-mcts -i -l1 -e3 -r10 -b500 -p train_smiles
similarity-mcts -i -l1 -e3 -r10 -b500 -p eval_smiles





If you want to specify a target and execute:

similarity-mcts -i -l1 -e3 -r10 -b500 -p train_smiles -t "CC(C)(C)C(NC(=O)C(F)(F)F)C(=O)N1CC2C(C1C1CCNC1=O)C2(C)C"
similarity-mcts -i -l1 -e3 -r10 -b500 -p eval_smiles -t "CC(C)(C)C(NC(=O)C(F)(F)F)C(=O)N1CC2C(C1C1CCNC1=O)C2(C)C"





similarity-mcts selects and outputs the candidates that can be the material of the fragments from the smiles list.
If you just want to output target-like molecules from the smiles list without running mcts:

similarity-genMols --help
similarity-genMols -t "CC1(C2C1C(N(C2)C(=O)C(C(C)(C)C)NC(=O)C(F)(F)F)C(=O)NC(CC3CCNC3=O)C#N)C" -m "CC1=CC=CC=C1C(C)C" "Cc1ccccc1CC(C#N)NC1CCNC1=O" -f "gen2.csv"







Chem-Classification

Output dataset in json format for chem-classification:

importSmiles -t "CC1(C2C1C(N(C2)C(=O)C(C(C)(C)C)NC(=O)C(F)(F)F)C(=O)NC(CC3CCNC3=O)C#N)C" -p "train_smiles"
importSmiles -t "CC1(C2C1C(N(C2)C(=O)C(C(C)(C)C)NC(=O)C(F)(F)F)C(=O)NC(CC3CCNC3=O)C#N)C" -p "eval_smiles"





If you want to output the dataset for regression model:

importSmiles -t "CC1(C2C1C(N(C2)C(=O)C(C(C)(C)C)NC(=O)C(F)(F)F)C(=O)NC(CC3CCNC3=O)C#N)C" -p "train_smiles" -r
importSmiles -t "CC1(C2C1C(N(C2)C(=O)C(C(C)(C)C)NC(=O)C(F)(F)F)C(=O)NC(CC3CCNC3=O)C#N)C" -p "eval_smiles" -r





Train the classification model and predict the similarity between Nirmatrelvir and YH-53:

from chem_classification.similarity_classification import SimilarityClassification
s = SimilarityClassification()
s.train_and_eval("train_smiles/smiles.json", "eval_smiles/smiles.json")
s.predict_smiles_pair(["CC1(C2C1C(N(C2)C(=O)C(C(C)(C)C)NC(=O)C(F)(F)F)C(=O)NC(CC3CCNC3=O)C#N)C", "CC(C)CC(C(=O)NC(CC1CCNC1=O)C(=O)C2=NC3=CC=CC=C3S2)NC(=O)C4=CC5=C(N4)C=CC=C5OC"])





Loading a local save:

s = SimilarityClassification("local-path/your-outputs")





Train regression model to predict similarity between Nirmatrelvir and YH-53:

from chem_classification.similarity_classification import SimilarityRegression
s = SimilarityRegression()
s.train_and_eval("train_smiles/smiles.json", "eval_smiles/smiles.json")
s.predict_smiles_pair(["CC1(C2C1C(N(C2)C(=O)C(C(C)(C)C)NC(=O)C(F)(F)F)C(=O)NC(CC3CCNC3=O)C#N)C", "CC(C)CC(C(=O)NC(CC1CCNC1=O)C(=O)C2=NC3=CC=CC=C3S2)NC(=O)C4=CC5=C(N4)C=CC=C5OC"])





Another regression model trained by json files output by similarity-mcts can predict the similarity with the target molecule from the material candidates and cooperate with similarity-ant:

similarity-mcts -i -l2 -e3 -r10 -b100 -p "train_smiles" -f "smiles.json" -j
similarity-mcts -i -l2 -e3 -r10 -b100 -p "eval_smiles" -f "smiles.json" -j






Note

From chem-ant 0.0.7,
I changed it to create datasets with molecular fragments as tokens, so the difference between the two regression models is gone.



Cooperation between chem-classification and similarity-ant (currently not working):

similarity-ant -n20 -g5 -b 1 -p gen_smiles -d -o "local-path/your-outputs"





Cooperation between regression model of chem-classification and similarity-ant:

similarity-ant -n20 -g5 -b 1 -p gen_smiles -r -o "local-path/your-outputs"









            

          

      

      

    

  

    
      
          
            
  
Chem-Ant Article


	author:

	Akihiro Kuroiwa



	date:

	2022/07/08



	abstract:

	I started writing chess-ant in 2019, but at first I was particular about minimax and the work did not proceed slowly.
With the COVID-19 outbreak of the cruise ship Diamond Princess in 2020, when the pandemic was finally beginning to attract attention,
I decided to use the chess-ant algorithm for the development of therapeutic agents.
After that, I read the paper of MCTS solver and the performance improved.
At the same time, I learned how to use the cheminformatics software.
Even after the SARS-CoV-2 pandemic has converged, the next pandemic is waiting.
Let’s contribute to society with our skills.






UCSF Chimera

On my old laptop Fujitsu LIFEBOOK AH42/C, when I try to install UCSF ChimeraX [https://www.cgl.ucsf.edu/chimerax/], I get the following error:

ERROR: ChimeraX requires OpenGL graphics version 3.3.
Your computer graphics driver provided version 2.1
Try updating your graphics driver.





Therefore, in this experiment, I use UCSF Chimera [https://www.rbvi.ucsf.edu/chimera/]. The advantage is that you can specify the binding site with the mouse.

chmod u+x chimera-alpha-linux_x86_64.bin
./chimera-alpha-linux_x86_64.bin





In ~/.profile on Ubuntu:

if [ -d "$HOME/.local/bin" ] ; then
    PATH="$HOME/.local/bin:$PATH"
fi





In my case, there are two installation locations:

~/.local/bin/
~/.local/UCSF-Chimera64-2022-05-18/





Run chimera from the terminal on the command line, or right-click the desktop icon to give execute permission and double-click to launch UCSF Chimera.

Prior to this experiment, get the latest release of the AutoDock Vina installer from GitHub [https://github.com/ccsb-scripps/AutoDock-Vina] and install it according to the manual.  You can check the location of the binary file with the following command:

cd ~/.local/bin/
ln -s vina_1.2.3_linux_x86_64 vina
which vina





To verify the operation, proceed with the experiment as follows:


	Create fragments of the target molecule Nirmatrelvir and output some molecules.


	Material candidates including the target molecule are selected by similarity-mcts, and some molecules are output.


	Get the set difference [https://stackoverflow.com/questions/18180763/set-difference-for-pandas].




similarity-genMols -t "CC1(C2C1C(N(C2)C(=O)C(C(C)(C)C)NC(=O)C(F)(F)F)C(=O)NC(CC3CCNC3=O)C#N)C" -m "CC1(C2C1C(N(C2)C(=O)C(C(C)(C)C)NC(=O)C(F)(F)F)C(=O)NC(CC3CCNC3=O)C#N)C" -b70 -p "gen_smiles" -f "gen1-1.csv"
similarity-mcts -l2 -e3 -r10 -b100 -p "gen_smiles" -f "gen1-2.csv"





After running, you would see something like this:

Material candidates: {'CC1(C2C1C(N(C2)C(=O)C(C(C)(C)C)NC(=O)C(F)(F)F)C(=O)NC(CC3CCNC3=O)C#N)C', 'CCCC1=NC(=C(N1CC2=CC=C(C=C2)C3=CC=CC=C3C4=NNN=N4)C(=O)O)C(C)(C)O'}





There are some things to keep in mind when running similarity-genMols.  Python doesn’t distinguish between single and double quotes, but bash and dash do.  In addition, you don’t need commas on the command line:

similarity-genMols -t "CC1(C2C1C(N(C2)C(=O)C(C(C)(C)C)NC(=O)C(F)(F)F)C(=O)NC(CC3CCNC3=O)C#N)C" -m "CC1(C2C1C(N(C2)C(=O)C(C(C)(C)C)NC(=O)C(F)(F)F)C(=O)NC(CC3CCNC3=O)C#N)C" "CCCC1=NC(=C(N1CC2=CC=C(C=C2)C3=CC=CC=C3C4=NNN=N4)C(=O)O)C(C)(C)O" -b100 -f gen1-2.csv
similarity-genMols -t "CC1(C2C1C(N(C2)C(=O)C(C(C)(C)C)NC(=O)C(F)(F)F)C(=O)NC(CC3CCNC3=O)C#N)C" -m "CCCC1=NC(=C(N1CC2=CC=C(C=C2)C3=CC=CC=C3C4=NNN=N4)C(=O)O)C(C)(C)O" -b100 -f gen1-3.csv





import pandas as pd
df1_1 = pd.read_csv("gen_smiles/gen1-1.csv", header=0, index_col=0)
df1_2 = pd.read_csv("gen_smiles/gen1-2.csv", header=0, index_col=0)
df1_3 = pd.read_csv("gen_smiles/gen1-3.csv", header=0, index_col=0)
df1_4 = pd.concat([df1_1, df1_1, df1_2, df1_3, df1_3], axis=0)
df1_4.drop_duplicates(subset="smiles", keep=False, inplace=True)
df1_4.sort_values(["lipinski", "dice_similarity"], inplace=True, ascending=False)
df1_4.reset_index(drop=True).to_csv("gen_smiles/gen1-4.csv")





Create a ligand file with Open Babel [http://openbabel.org/wiki/Main_Page].  Open gen3.csv and specify the smiles of high-scoring molecule with similarity-mcts.  Don’t forget to add hydrogen atoms and assign partial charges.  On Ubuntu:

sudo apt install openbabel
obabel -L
obabel -L charges
obabel -h -c -ican -:"CCCC1C2C(CN1C(=O)C1C3C(CN1C(=O)C(F)(F)F)C3(C)C)C2(C)C" -opdbqt -O ligand.pdbqt --gen3D --partialcharge gasteiger





Let’s go back to UCSF Chimera. Open the above file and follow the menu as follows:


	File ‣ Fetch Structure by ID ‣ PDB(mmCIF) ‣ 7tll


	File ‣ Open ‣ ligand.pdbqt ‣ file type PDB


	Tools ‣ Surface/Binding Analysis ‣ AutoDock Vina




Our Output file is all.
Specify Receptor and Ligand.
Check Resize search volume using for your mouse.
Write vina path in Executable location.

In my case, when I specified the binding site with the mouse, the frame was not displayed unless I switched it with the Presets menu.
When reconfirming the experimental results, open all.receptor.pdb and:


	Tools ‣ Surface/Binding Analysis ‣ ViewDock ‣ all.pdbqt


	Move ‣ Play






AutoDock Vina

Reuse the receptor file output by UCSF Chimera and experiment on the command line.
You will prepare your own ligand file.
The contents of conf.txt are as follows:

receptor = all.receptor.pdbqt
ligand = ligand.pdbqt

out = all.pdbqt

center_x = -2.68714
center_y = -1.23572
center_z = 13.8821

size_x = 25.747
size_y = 22.6627
size_z = 22.1881





similarity-mcts now chose Catechin and the mysterious molecule Gnididin [1]:

similarity-mcts -l2 -e3 -r10 -b100 -p "gen_smiles" -f "gen2-2.csv"





Material candidates: {'C1C(C(OC2=CC(=CC(=C21)O)O)C3=CC(=C(C=C3)O)O)O', 'CCCCCC=CC=CC(=O)OC1C(C23C4C=C(C(=O)C4(C(C5(C(C2C6C1(OC(O6)(O3)C7=CC=CC=C7)C(=C)C)O5)CO)O)O)C)C'}





gen2-2.csv:

,smiles,dice_similarity,lipinski
0,C=C(C)C12OC3(CO)OC1C1C4OC4(CO)C(O)C4(O)C(=O)C(C)=CC4C1(O3)C(C)C2CO,0.19672131147540983,1.0





Unfortunately, this molecule is made up of fragments produced solely by Gnididin:

obabel -h -c -ican -:"C=C(C)C12OC3(CO)OC1C1C4OC4(CO)C(O)C4(O)C(=O)C(C)=CC4C1(O3)C(C)C2CO" -opdbqt -O ligand.pdbqt --gen3D --partialcharge gasteiger





Execute AutoDock Vina:

vina --config conf.txt





mode |   affinity | dist from best mode
     | (kcal/mol) | rmsd l.b.| rmsd u.b.
-----+------------+----------+----------
   1       -8.765          0          0
   2        -8.31       1.82      6.828
   3       -8.252      2.441      4.152
   4       -8.086      1.664      7.041
   5        -7.85      2.301      7.148
   6       -7.825      1.726      6.693
   7       -7.797      3.008      6.184
   8       -7.412      2.183      7.011
   9       -7.339      2.426      4.168







Mold for Smiles Casting

The amino acid interaction described in this paper [2] is based on PDB ID: 6LU7 [https://www.rcsb.org/structure/6lu7], while our experiments are based on the SARS-CoV-2 Mpro Omicron P132H contained in PDB ID: 7TLL [https://www.rcsb.org/structure/7tll].
The first three letters of active site amino acid are abbreviations for amino acids, and the rest represent the positions of sequences.
Let’s check with UCSF Chimera:


	Presets ‣ Interactive 1 (ribbons) with chimera.


	Hover your cursor over the receptor’s active site amino acid on the binding site to see its location.


	Display a nucleotide or amino acid sequence alignment with chimera from Tools ‣ Sequence ‣ Sequence and save it in fast format.


	If you want to check the Active site amino acid, right-click on the relevant part of the sequence.




If you cast from a mold, the casting should fit the original mold.
That’s why I added amino acids and nucleotides to the file smiles.csv [3].
Whether the relationship between the binding site and the ligand in docking simulation can be said to be the same, let’s experiment with the following method:


	Convert the relevant part to smiles with rdkit.  The range is from Phe140 to Glu166 in sequence.


	The smiles string is so long, let’s break it down into fragments and outputs them to some molecules.




from rdkit import Chem
from rdkit.Chem import BRICS
Chem.MolToSmiles(Chem.MolFromFASTA("FLNGSCGSVGFNIDYDCVSFCYMHHME"))
smiles = 'CC[C@H](C)[C@H](NC(=O)[C@H](CC(N)=O)NC(=O)[C@H](Cc1ccccc1)NC(=O)CNC(=O)[C@@H](NC(=O)[C@H](CO)NC(=O)CNC(=O)[C@H](CS)NC(=O)[C@H](CO)NC(=O)CNC(=O)[C@H](CC(N)=O)NC(=O)[C@H](CC(C)C)NC(=O)[C@@H](N)Cc1ccccc1)C(C)C)C(=O)N[C@@H](CC(=O)O)C(=O)N[C@@H](Cc1ccc(O)cc1)C(=O)N[C@@H](CC(=O)O)C(=O)N[C@@H](CS)C(=O)N[C@H](C(=O)N[C@@H](CO)C(=O)N[C@@H](Cc1ccccc1)C(=O)N[C@@H](CS)C(=O)N[C@@H](Cc1ccc(O)cc1)C(=O)N[C@@H](CCSC)C(=O)N[C@@H](Cc1c[nH]cn1)C(=O)N[C@@H](Cc1c[nH]cn1)C(=O)N[C@@H](CCSC)C(=O)N[C@@H](CCC(=O)O)C(=O)O)C(C)C'
allfrags = set()
allfrags.update(BRICS.BRICSDecompose(Chem.MolFromSmiles(smiles), returnMols=True))
builder = BRICS.BRICSBuild(allfrags)
generated_smiles = []
for i in range(30):
    mol = next(builder)
    mol.UpdatePropertyCache(strict=True)
    generated_smiles.append(Chem.MolToSmiles(mol))
generated_smiles
['CSCC[C@H](SC)C(=O)N[C@@H](CCC(=O)O)C(=O)O', 'CSCC[C@H](SC)C(=O)Nc1c[nH]cn1', 'CSCC[C@H](SC)C(=O)Nc1ccc(O)cc1', 'CSCC[C@H](SC)C(=O)Nc1ccccc1', 'CS[C@@H](CC(C)C)C(=O)Nc1ccc(O)cc1', 'CC(C)C[C@H](N[C@@H](CCC(=O)O)C(=O)O)C(=O)Nc1ccc(O)cc1', 'CC(C)C[C@H](Nc1ccc(O)cc1)C(=O)Nc1ccc(O)cc1', 'CC(C)C[C@H](Nc1ccccc1)C(=O)Nc1ccc(O)cc1', 'CC(C)C[C@H](Nc1c[nH]cn1)C(=O)Nc1ccc(O)cc1', 'CS[C@@H](CC(C)C)C(=O)Nc1c[nH]cn1', 'CS[C@@H](CC(C)C)C(=O)Nc1ccccc1', 'CS[C@@H](CC(C)C)C(=O)N[C@@H](CCC(=O)O)C(=O)O', 'CS[C@@H](CC(=O)O)C(=O)NC(=O)[C@H](CC(C)C)SC', 'CS[C@@H](CC(C)C)C(=O)NC(=O)[C@@H](SC)C(C)C', 'CS[C@@H](CC(N)=O)C(=O)NC(=O)[C@H](CC(C)C)SC', 'CS[C@@H](CC(C)C)C(=O)NC(=O)[C@H](CS)SC', 'CS[C@@H](CC(C)C)C(=O)NC(=O)[C@@H](N)Cc1c[nH]cn1', 'CS[C@@H](CC(C)C)C(=O)NC(=O)[C@@H](N)Cc1ccc(O)cc1', 'CS[C@@H](CC(C)C)C(=O)NC(=O)[C@@H](N)Cc1ccccc1', 'CS[C@@H](CO)C(=O)NC(=O)[C@H](CC(C)C)SC', 'CS[C@@H](CC(C)C)C(=O)NC(=O)[C@H](CC(C)C)SC', 'CC[C@H](C)[C@H](SC)C(=O)NC(=O)[C@H](CC(C)C)SC', 'CSCC(=O)NC(=O)[C@H](CC(C)C)SC', 'CC(C)C[C@H](N[C@@H](CCC(=O)O)C(=O)O)C(=O)Nc1ccccc1', 'CC(C)C[C@H](Nc1c[nH]cn1)C(=O)Nc1ccccc1', 'CC(C)C[C@H](Nc1ccc(O)cc1)C(=O)Nc1ccccc1', 'CC(C)C[C@H](Nc1ccccc1)C(=O)Nc1ccccc1', 'CC(C)C[C@H](Nc1ccc(O)cc1)C(=O)N[C@@H](CCC(=O)O)C(=O)O', 'CC(C)C[C@H](Nc1ccccc1)C(=O)N[C@@H](CCC(=O)O)C(=O)O', 'CC(C)C[C@H](N[C@@H](CCC(=O)O)C(=O)O)C(=O)N[C@@H](CCC(=O)O)C(=O)O']






	From the output molecules, select the molecules with good results by docking simulation. Of course, it’s a good result among the options.


	Run similarity-mcts targeting that molecule.




obabel -h -c -ican -:"CC(C)C[C@H](Nc1ccc(O)cc1)C(=O)N[C@@H](CCC(=O)O)C(=O)O" -opdbqt -O ligand.pdbqt --gen3D --partialcharge gasteiger
vina --config conf.txt





mode |   affinity | dist from best mode
     | (kcal/mol) | rmsd l.b.| rmsd u.b.
-----+------------+----------+----------
   1       -7.192          0          0
   2       -7.014      2.837      4.843
   3       -7.002      1.339      2.292
   4       -7.001      2.143      4.417
   5       -6.894      1.303       2.67
   6       -6.759      2.539       6.62
   7       -6.578      2.329      7.121
   8       -6.547      3.004      7.767
   9        -6.51        1.3      2.908





similarity-mcts -i -l2 -e3 -r10 -b100 -p "gen_smiles" -f "gen3-2.csv" -t "CC(C)C[C@H](Nc1ccc(O)cc1)C(=O)N[C@@H](CCC(=O)O)C(=O)O"





Material candidates: {'CC1CCC2C(C(OC3C24C1CCC(O3)(OO4)C)OC)C', 'C(CCN)CC(C(=O)O)N', 'CC(C)C[C@H](Nc1ccc(O)cc1)C(=O)N[C@@H](CCC(=O)O)C(=O)O'}





,smiles,dice_similarity,lipinski
0,CCNC1CCNC1=O,0.5454545454545454,1.0
1,CC(Nc1ccccc1)C(=O)Oc1ccccc1,0.5269607843137255,1.0
2,COC(=O)[C@H](CC(C)C)Nc1ccc(O)cc1,0.5084427767354597,1.0
3,CC(C)C(=O)OC(=O)C(C)C,0.5078125,1.0
4,O=C1NCCC1Nc1ccc(F)cc1,0.5066162570888468,1.0
5,COC(=O)[C@H](CC(C)C)OC,0.5040983606557377,1.0
6,C(c1nn[nH]n1)c1nn[nH]n1,0.4921875,1.0
7,CCOc1nn[nH]n1,0.4765625,1.0
8,COc1ccc(O)cc1,0.46875,1.0
9,CO[C@@H](CCC(=O)O)C(=O)O,0.4609053497942387,1.0
10,CC(C(=O)N1Cc2ccccc2CC1C(=O)O)N1Cc2ccccc2CC1c1ccccc1,0.4494649227110582,1.0
11,CC(C(=O)N1Cc2ccccc2CC1C(=O)O)N1Cc2ccccc2CC1C(=O)O,0.4436183395291202,1.0
12,c1ccc(C2CC3CCCC3N2c2ccccc2)cc1,0.4426666666666666,1.0
13,COC(=O)[C@H](CC(C)C)NC1OC2OC3(C)CCC4C(C)CCC(C1C)C24OO3,0.43861607142857145,1.0
14,O=C(O)C1Cc2ccccc2CN1c1ccccc1,0.4348387096774193,1.0
15,CC1CCC2C(C)C(Nc3ccc(O)cc3)OC3OC4(C)CCC1C32OO4,0.4311717861205916,1.0
16,CO[C@@H](CC(C)C)C(=O)NC1OC2OC3(C)CCC4C(C)CCC(C1C)C24OO3,0.4242761692650334,1.0
17,CC(C(=O)Oc1ccccc1)N1C(c2ccccc2)CC2CCCC21,0.4230287859824781,1.0
18,CCOc1ccccc1C(=O)O,0.4228971962616822,1.0
19,Cc1cc(NC2CCNC2=O)no1,0.4113924050632911,1.0





Ignore short smiles:

obabel -h -c -ican -:"CC(C(=O)N1Cc2ccccc2CC1C(=O)O)N1Cc2ccccc2CC1c1ccccc1" -opdbqt -O ligand.pdbqt --gen3D --partialcharge gasteiger
vina --config conf.txt





mode |   affinity | dist from best mode
     | (kcal/mol) | rmsd l.b.| rmsd u.b.
-----+------------+----------+----------
   1       -8.417          0          0
   2       -8.302      2.467      6.754
   3       -8.003       4.96      7.503
   4       -7.624      3.907      6.517
   5       -7.506      5.171      7.983
   6       -7.485      2.979      5.385
   7       -7.433      5.416      9.353
   8       -7.375      2.857      5.204
   9       -7.296      2.998      5.526





If you need the target molecule itself, the above method may be useful.


Todo


	Separate MCTS solver as another package.


	Is it possible to get a high score by docking simulation without the target molecule?


	Type bool is output as 1.0 or 0.0 in a csv file.


	similarity-ant is so slow that it is far from practical.


	Is similarity-mcts working properly in the first place?


	Version 0.0.3 of similarity-mcts now imports MCTS solver, so the output is slightly different from this document.


	Unravel the entangled spaghetti code.
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Chem-Ant Project - Co-Founding Members Wanted


Overview:

The Chem-Ant Project is actively seeking co-founding members to join in the pursuit of innovative approaches to drug candidate exploration. Currently, the project is in search of individuals to join as co-founders. This project involves simulations utilizing rdkit, deap’s genetic programming, and an MCTS solver. The company has not yet been established, and at present, I am the sole project leader.



Open Positions:


	Software Developers


	Data Scientists


	Cheminformatics Experts


	Marketing Specialist


	Others interested in the project






Desired Skills:


	Knowledge in Cheminformatics, Molecular Biology, or related fields


	Programming skills (Python, etc.)


	Teamwork and communication abilities






How to Apply:

If you are interested, please reach out to the email address listed in the git log. Additionally, providing a brief introduction and your skill set would be appreciated.



Note:

Chem-Ant has not been formally established and is currently progressing as a project. This is a pioneering initiative towards future company formation, welcoming individuals who want to grow together and venture into the forefront of novel drug development.
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